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Troubleshooting Your Design with the TDS1000B and 
TDS2000B Series Oscilloscope

Today’s engineers and technicians face increasingly complex
and critical troubleshooting tasks. New digital designs 
often challenge designers with new problems to find: race
conditions, transients, signal aberrations, bus contention
problems, etc. And, of course, competitive time-to-market
pressures dictate that troubleshooting must be completed
quickly and accurately. 

The TDS1000B and TDS2000B Series delivers the perform-
ance, affordability and portability that enable engineers 
and technicians to tackle these challenges – quickly and
easily. More than just a matter of basic bandwidth, these
oscilloscopes enable users to solve problems quickly, 
helping them to establish that a problem exists, allowing
them to capture the problem accurately, and enabling 
them to analyze it to determine the root cause. 

The tips on the following pages are designed to further 
simplify your troubleshooting tasks. But if you need more
help, there is plenty available. Simply contact your local
Tektronix representative, authorized distributor, or visit
www.tektronix.com/oscilloscopes 

40, 60, 100, and 200 MHz models 

Up to 2 GS/s sample rate on all channels 

Built-in USB host and device ports standard 

Easy documentation and analysis with PC connectivity
software

Lifetime warranty*

* Limitations apply. For terms and conditions, 
visit www.tektronix.com/lifetimewarranty

www.tektronix.com/oscilloscopes



Getting Started
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To optimize your troubleshooting task at hand, it is 
important to start at the beginning – with proper probe 
compensation and attenuation, default setup, and 
automatic instrument setup.

www.tektronix.com/oscilloscopes

To properly compensate and attenuate your
probe, follow these simple steps: 

1. Connect the probe to channel 1.

2. Attach the probe tip and reference lead to the PROBE 

COMP connectors. If using the probe hook-tip, ensure a 
proper connection by firmly twisting the tip onto the probe.

3. Push PROBE CHECK.

4. The oscilloscope will automatically check the probe 
attenuation and check the shape of the displayed waveform 
to determine if your probe is compensated correctly. 

5. If necessary, it will instruct you to adjust your probe 
compensation.

To ensure that you begin with factory initial-
ization settings, follow these simple steps: 

1. Press the front panel DEFAULT SETUP button. 

2. Press the front panel AUTOSET button.

PROBE COMP AUTOSET
button

CH 1

Overcompensated

Undercompensated

Compensated Correctly

P2220
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Capture Elusive Glitches

To use the Peak Detect feature: 

1. Display the waveform on the screen. 

2. Press the ACQUIRE front panel menu button. 

3. Press the Peak Detect menu button. 

4. Notice that the oscilloscope captures several very narrow 
glitches, even at slow sweep speeds. Without peak 
detect, you would not have seen many of these glitches.

In today’s high-speed digital designs, elusive glitches and
random anomalies can cause circuits to fail. While finding
these glitches has never been easy, the TDS1000B and

TDS2000B Series simplifies this task with its peak detect
feature. Peak detect can capture narrow glitches, even on
low-frequency signals.

www.tektronix.com/oscilloscopes



To use Display Persistence: 

1. Display the waveform on the screen.

2. Press the DISPLAY front panel menu button.

3. Press the Persist menu button until the desired amount of 
persistence is selected.

4. Notice that the most recent signal is highlighted in the display.
By monitoring the screen updates, you can judge the relative 
frequency-of-occurrence of the signal anomalies.

Capture Elusive Glitches (continued)
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Intermittent signal anomalies can also be a challenge to see.
The TDS1000B and TDS2000B Series provides variable- and
infinite-persistence display capabilities to provide you with

information about the signal variations over time, making it
easier to understand the characteristics of the transients
you’ve captured.

www.tektronix.com/oscilloscopes
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Debug Digital Timing Problems

To use the pulse width trigger: 

1. Press the TRIG MENU front panel button.

2. In the side menu, press Type until Pulse is selected. 

3. Press the When side menu button until < is selected.

4. Use the multipurpose knob to set the desired minimum 
pulse width.

5. Select, as desired, Source, Polarity, Mode, and 

Coupling. 

Digital designers need to quickly find and analyze a wide
range of circuit timing problems. For example, race 
conditions and transients can cause circuits to perform 
inaccurately. The TDS1000B and TDS2000B Series’ 

pulse width trigger can help troubleshoot such situations 
by triggering when a signal pulse width is less than, greater
than, equal to or not equal to a specified pulse width.

www.tektronix.com/oscilloscopes



To make timing measurements using cursors: 

1. Press the CURSOR button. 

2. Press the Type menu button until the Time cursor type is 
selected. 

3. Press the Cursor 1 menu button.

4. To measure the timing relationship between two signals, 
place cursor 1 on the first edge of interest, using the 
multipurpose knob. 

5. Press the Cursor 2 button and place cursor 2 on the 
second edge of interest, at approximately the same Voltage. 

6. The cursor readouts indicate the timing of the cursors 
relative to the trigger point. In this example, the ∆t readout 
indicates the period of the waveform, and the 1/∆t is the 
frequency of the signal. 

Verify Timing Relationships
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Electronics engineers often need to verify that their circuits 
are working as designed. One of the most common types 
of oscilloscope measurements is timing measurements, 

such as pulse width, period, and frequency. The TDS1000B
and TDS2000B Series’ cursors can be used to make such
measurements quickly and easily. 

www.tektronix.com/oscilloscopes
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Check Signal Integrity

To make signal integrity measurements
using cursors: 

1. Press the CURSOR button.

2. Press the Type menu button until the Amplitude cursor 
type is selected.

3. Press the Cursor 1 menu button.

4. To measure the peak ringing below ground, 
place cursor 1 at 0 Volts, using the multipurpose knob. 

5. Press the Cursor 2 menu button and place cursor 2 
on the negative peak, using the multipurpose knob. 

6. View the absolute Voltage measurements on the cursor 
readouts at the side of the display. The ∆ readout 
indicates the difference between the cursor positions. 

Electronics engineers may discover that a wide array of 
unintentional electrical events will make a difference in how
circuits function in the real world. To characterize these
events, engineers can measure criteria such as overshoot,

ringing, ground bounce, cross talk, and other signal integrity
issues. The TDS1000B and TDS2000B Series’ cursors can
be used to make such measurements. 

www.tektronix.com/oscilloscopes



To make signal integrity measurements 
using automatic measurement system: 

1. Press the MEASURE front panel button.

2. Press a CH1 side menu button to add an automatic 
measurement.

3. Press the Type side menu button until you find the 
desired measurement, and then press Back.

4. Repeat steps 2 and 3 to select and display up to 5 
measurements.

5. View the selected measurements on the right side of 
the display.

Check Signal Integrity (continued)
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The TDS1000B and TDS2000B Series’ automatic measure-
ment system can also be used to make such measurements
quickly and automatically. 

www.tektronix.com/oscilloscopes
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Debugging Digital System Lock-up

1. Press TRIG MENU front panel button.

2. Press Type side button until Pulse is selected.

3. Press When until > is selected.

4. Using the multipurpose knob, set Pulse Width to slightly 
longer than the clock pulse.

5. Press –more– and press Polarity until Negative is 
selected.

6. You can also adjust the TRIGGER LEVEL to capture 
low-amplitude or “runt” pulses.

One common cause of digital system lock-ups is an 
intermittent clock. The TDS1000B and TDS2000B Series
trigger system can quickly and easily identify unexpected
interruptions in the clock signal.

www.tektronix.com/oscilloscopes



1. Connect the video signal to the oscilloscope using proper 
adapters and a 75 Ω terminator, if necessary. 

2. Press the AUTOSET front panel button. 

3. Press the Line/Field side button to select video line 
triggering. If a broadcast-standard video waveform is present,
the oscilloscope will display a stable video waveform that is 
triggered on all lines. 

4. To add some display persistence, press DISPLAY and 
press Persist to select the desired persistence.

5. Adjust vertical position and scale as desired. 

6. To adjust trigger setup, press TRIG MENU and change 
Source, Polarity, and video Standard.

7. If desired, reconnect the oscilloscope to other test points. 
You do not need to change any oscilloscope settings. 

Test For The Presence of Video Signals
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Video technicians must perform a quick check for the 
presence of a video signal at different test points. If the site 
is in the field, technicians will need lightweight, portable test

equipment gear that they can easily carry to each location.
The TDS1000B and TDS2000B Series’ video trigger features
make this oscilloscope a valuable tool for these technicians. 

www.tektronix.com/oscilloscopes
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Test Each Line of a Video Signal

1. Connect the video signal to the oscilloscope using proper 
adapters and a 75 Ω terminator, if necessary.

2. Press the AUTOSET front panel button.

3. Adjust vertical position and scale as desired.

4. Press the TRIG MENU button.

5. Press the Sync menu button until Line Number is 
displayed.

6. You can use the multipurpose knob to examine each 
video line.

Video technicians may need to check one or more video
lines. They may need to search for defective pixels in 
a Charge-Coupled Device (CCD) video camera. The

TDS1000B and TDS2000B Series’ video triggers enable
technicians to test each line of a video signal.

www.tektronix.com/oscilloscopes



Engineers and technicians can use the Fast Fourier Transform
(FFT) to break down signals into component frequencies,
which the oscilloscope uses to display a graph of the 
frequency domain of a signal, as opposed to the oscillo-
scope’s standard time domain graph. 

Developers can then associate those frequencies with 
known system frequencies, such as system clocks, 
oscillators, read/write strobes, display signals, or switching
power supplies.

Look for Unintentional Circuit Noise
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Developers need to check for unintended noise in their 
prototypes. However, noisy signals can be difficult to analyze
in the time domain, as shown below. 

www.tektronix.com/oscilloscopes
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Look for Unintentional Circuit Noise (continued)

1. Press the front panel MATH button. 

2. Press the Operation menu button until FFT is selected. 

3. Press the Window menu button until the Hanning

window is selected, which provides the highest frequency
resolution.

4. If desired, use the vertical and horizontal POSITION

and SCALE controls to magnify and position the 
FFT waveform.

5. Cursors can be used to accurately measure the FFT 
waveform. Press CURSOR.

6. Press the Source menu button until MATH is selected.

7. Press the Type menu button until Frequency is selected.

8. Press the Cursor 1 menu button. Using the multipurpose 
knob, position cursor 1 at the left side of the display.

9. Press the Cursor 2 menu button. Position cursor 2 on 
the highest point in the display.

10. The readout indicates one of the sources of noise. 
In this case, the 20 MHz signal is the system clock, 
which is coupling into the signal.

The TDS1000B and TDS2000B Series offers a standard FFT
feature, making it an ideal tool for these identifying sources
of noise in a circuit. To create and FFT display:

www.tektronix.com/oscilloscopes



To display the power line harmonics on a 
current waveform:

1. Press the CH 1 MENU front panel button.

2. Press the Probe side menu button.

3. Press the Current side menu button to select current 
probe support.

4. Press the Scale side menu button to select the appropriate 
current probe scale factor.

5. Notice the readouts at the bottom of the display, where the 
waveform’s vertical units are now in milliAmps (mA).

6. Press the MATH front panel button.

7. Press the Operation side menu button until FFT is selected.

8. Press the Window side menu button until Flattop is selected.
This window is best for measuring amplitudes accurately.

Power Line Harmonic Analysis
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Power circuit designers often need to analyze the effects 
of their circuits on the power line. Although an ideal power 
supply would present a constant load on a power line, 
real power supply circuits do not, creating harmonics on 

the power line. The TDS1000B and TDS2000B provide simple
tools to measure power supply currents and analyze the 
harmonics on a power line. 

www.tektronix.com/oscilloscopes
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Power Line Harmonic Analysis (continued)

1. Press the CURSOR front panel button.

2. Press the Source side menu button until MATH is 
selected.

3. Press the Type side menu button until Frequency is 
selected.

4. Press the Cursor 1 side menu button and use the 
multipurpose knob to align the cross-hair cursor on the 
left-most peak (the fundamental).

5. Press the Cursor 2 side menu button and use the 
multipurpose knob to align the cross-hair cursor on the 
next-highest peak (the 3rd harmonic, in this case).

6. The readouts at the right of the screen indicated the 
absolute and relative frequencies and magnitudes.

The FFT display provides a frequency-domain display of 
the power line signal, including the fundamental power line
frequency and the harmonics at integer multiples of the 

fundamental frequency. The TDS1000B and TDS2000B 
cursor measurements provide an easy and accurate way 
to analyze this complex display.

www.tektronix.com/oscilloscopes



1. Acquire the signal.

2. Connect the oscilloscope to the PC using a USB cable.

3. Launch the OpenChoice Desktop program.

4. Click Select Instrument, choose the correct USB instrument,
and click OK.

5. Click Get Screen to capture the screen image.

6. Click Save As to save the screen image to a file on the PC.

7. Click Copy to Clipboard. You can then launch your 
documentation program and paste the image into 
the document.

Documenting Your Results with OpenChoice® Software
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Design engineers in the lab and technicians in the field often
need to document the work they do with their oscilloscope.
They can save screen images to a removable memory device

and then manually copy the files to their PC. The easy-to-use
OpenChoice Desktop simplifies these documentation tasks by
directly transferring screen images to your PC over USB.

www.tektronix.com/oscilloscopes
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Waveform Measurements Logging

1. Acquire the signal.

2. Connect the oscilloscope to the PC using a USB cable.

3. Launch Excel and enable the TekXL toolbar by selecting 
Tools Add-ins… and checking the box next to 
Tekxltoolbar.

4. Press the TekXL Connection icon, select the desired
instrument, and press OK.

5. Press the TekXL Measurements icon.

6. On the Selection tab, choose Frequency.

7. On the Timing tab, select 45 samples.

8. On the Charting tab, choose Upon Completion.

A common task for engineers and technicians is to make
measurements on their oscilloscope and then manually
record measurements to document circuit performance 
variations over time. However, this is time-consuming 

and can lead to inconsistent quality of documentation. 
The easy-to-use TekXL toolbar simplifies data gathering 
and documentation tasks inside Excel.

www.tektronix.com/oscilloscopes



1. Acquire the signal.

2. Connect the oscilloscope to the PC using a USB cable.

3. Launch the SignalExpress TE program.

4. SignalExpress will open with the instrument automatically 
connected and transferring data to the PC.

5. To conduct a limit test of the signal against specified limits, 
select Add Step Analog Test Limit Test.

6. To display the histogram of the signal, select Add Step 

Analog Time-Domain Measurements Histogram.

Waveform Analysis Using NI SignalExpress™ Tektronix Edition Software
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Although the TDS1000B and TDS2000B provide significant
on-board analysis capabilities, there are applications where
the analysis requirements are better met with PC-based 

applications. SignalExpress Tektronix Edition provides
advanced analysis capabilities with the ease of USB 
plug-and-play.

www.tektronix.com/oscilloscopes





For Further Information
Tektronix maintains a comprehensive, constantly expanding
collection of application notes, technical briefs and other
resources to help engineers working on the cutting edge of
technology. Please visit www.tektronix.com

Copyright © 2006, Tektronix. All rights reserved. Tektronix products are covered by
U.S. and foreign patents, issued and pending. Information in this publication super-
sedes that in all previously published material. Specification and price change
privileges reserved. TEKTRONIX and TEK are registered trademarks of Tektronix,
Inc. All other trade names referenced are the service marks, trademarks or regis-
tered trademarks of their respective companies.  
011/06   DV/WF/   xxx 3GW-19696-1




